Connexion browser known problems

Last updated: Thu, 15 Apr 2021 13:43:51 GMT

Find known issues for the Connexion browser.
Known problems
<table>
<thead>
<tr>
<th>ISSUE</th>
<th>DATE IDENTIFIED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connexion sorts words that include diacritics out of order in WorldCat derived and keyword search results</td>
<td>November 13, 2005</td>
</tr>
<tr>
<td>(Partly resolved - for derived search results only - with system changes November 13, 2005)</td>
<td></td>
</tr>
<tr>
<td>When WorldCat derived and keyword results include words with diacritics, the records sort out of sequence with words that do not have diacritics, whether you use the client or the browser interface.</td>
<td></td>
</tr>
<tr>
<td><strong>Examples:</strong></td>
<td></td>
</tr>
<tr>
<td>• A personal name keyword search for lutz, m* returns Lutz, Madeleine, Lütz, Manfred, and Lutz, Marcel, but Lütz, Manfred incorrectly appears first in the sequence.</td>
<td>August 22, 2005</td>
</tr>
<tr>
<td>• A personal name derived search for lutz,m, results in the following order of records retrieved: Lutzki, Moses, Lutzky, M., Lutzky, Morton, Lütze, Max, Lützeler, Marga.</td>
<td></td>
</tr>
<tr>
<td><strong>Workarounds</strong></td>
<td></td>
</tr>
<tr>
<td>1. In the client only, you can click the column heading in the list to re-sort, although the re-sort is not always 100% correct. Or</td>
<td></td>
</tr>
<tr>
<td>2. In the client or browser, browse (scan an index) for the term instead—Connexion normalizes the headings by removing the diacritics, so the results display correctly.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution: Whether to retain or omit a comma in a browse term for the LC names and subjects authority file depends on the index you browse</strong></td>
<td>August 22, 2005</td>
</tr>
<tr>
<td>Retain a comma in a term you use to browse the LC authority file only when you browse the personal name index and the topical index. Exclude a comma from a term when you browse the LCSH index.</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong> Browse for authors, english in the topicals index. Browse for authors english in the LCSH index.</td>
<td></td>
</tr>
<tr>
<td><strong>Validation set to None may have implications for offline services</strong></td>
<td>November 13, 2005</td>
</tr>
</tbody>
</table>
If you have validation set to None for setting holdings (General tab > Admin > Cataloging Options / Validation Levels), invalid characters in records will not produce an error message when you update holdings on an existing record or delete your holdings. However, the system will convert invalid characters to fill characters in your archive files.

Internet Resources appear under Books in the group list, but actually are correctly retrieved by your search

Currently, records that meet specific requirements (presence of 856 with appropriate indicators) are given the primary document type of Internet Resources, but Connexion group lists do not yet include Internet Resources as a separate group heading. Instead, Internet resource records are included under Books in group lists, regardless of how the fixed field is coded. These groupings are for display purposes only. They reflect the actual format of the records, except for the inclusion of these Internet resources in any format.

For example, the search pb:naxos and hl:trios and mt:rec retrieves records for streaming video that are grouped under the Books format, even though the records are in the sound recordings format, with 006 fields for electronic resource/computer files, an 007 for sound recordings, and an 007 for the computer file.

For now, you can limit a search to non-Internet items (not mt:url) to retrieve and display non-Internet items under the "correct" format heading in a group list. If you intend to retrieve both Internet and non-Internet items, be aware that any Internet resource records that match the search will be found under the Books format if you get a WorldCat group list.

Inappropriate message may appear when exporting authority records

On occasion, you may receive the following message when you export authority records: "This main entry exists in another authority record: LCCN=n ####### ARN=oca########." You receive the message as a result of a process that normalizes the main entry to help reduce duplicate records. Currently, tags are not considered in the normalization process.

The message occurs when you validate the record (Edit list, Validate Record) before exporting or when you have the validation level set to "Full" in the General tab,
Preferences, Cataloging Options, under Validation Level Options.

If you used Edit, Validate Record, you can go ahead and export with no problem. If you have the validation level set to "Full," change it to "Basic" and then export the record.

---

**Incorrect record counts in browse results for authority records**

Browse results for authority records display headings and record counts from a list that the system does not update immediately when authority records are added or replaced. In the past, updates were immediate but caused an adverse effect on overall system response time. This was formerly a problem with WorldCat search results. OCLC is working on database architecture and indexing to overcome this problem for authority browse results, while balancing the need to provide reasonable system response time for searching.

February 2, 2006

---

**False error message may result from system duplicate detection when new authority records are added or WorldCat records are replaced**

The system uses NACO Normalization rules to match the 1XX heading of any record you want to add or replace against the 1XX and 4XX name headings to detect duplicates. However, the system incorrectly ignores the first comma in subfield a, which results in an incorrect validation error message—This main entry exists in another authority record: LCCN=xx xxxxx ARN=ocaxxxxx. If you receive this message as a result of this problem, and the new/replace heading is not a duplicate, click OK to close the message, and simply re-issue the Add or Replace command to successfully add or replace the record.

June 14, 2006

---

**Special characters and diacritics in CD name and CD My Status cause errors**

When you create a constant data (CD) record, avoid using the following special characters and diacritics in either the CD name or optional My status you assign to identify the CD record. These characters can cause errors when you use the CD record (retrieve, save, apply, delete, etc.). For example, errors prevent you from deleting these CD records, either singly (from the full record) or in a group (from a list of CD records). Problems occur because CD records whose names contain special characters cannot be indexed correctly.

December 1, 2006
Do not use...

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Equivalent</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Period (full stop)</td>
<td>Ampersand</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
<td>Pound sign</td>
</tr>
<tr>
<td>;</td>
<td>Semicolon</td>
<td>Double quotation marks</td>
</tr>
<tr>
<td>:</td>
<td>Colon</td>
<td>Apostrophe</td>
</tr>
<tr>
<td>_</td>
<td>Underscore</td>
<td>Percent mark</td>
</tr>
<tr>
<td>*</td>
<td>Asterisk</td>
<td>Question mark</td>
</tr>
<tr>
<td>+</td>
<td>Plus sign</td>
<td>Slash</td>
</tr>
</tbody>
</table>

To be sure that CD records are problem-free, use only standard letters (upper- and lowercase) and numbers in CD names and My Statuses.

Pathfinder default CD: Cannot show Default CD (Pathfinders tab)

When you select Default CD on the Show list (Pathfinders tab), your action ends with a system error message:

"System Failure Page: Unable to successfully complete transaction."

Workaround: Search the Pathfinder constant data file and view your default constant data record.

Browsing for a personal name with abbreviated surname -- replace the period with a space in browse query

When browsing for a personal name that ends with a
period as part of an abbreviated surname, do not include the period in the browse query. To retrieve the desired heading, substitute a space for the period.

Example: To browse for the name Harry L., enter the following query:

L, Harry

Not: L., Harry

or: L, Harry

Show Active Records command results in blank screen

When you select Active Records from the Show Options list to view all records currently open, the system returns a blank screen. Clicking the Show Active Records link on the End Your Session screen also results in a blank screen.

Searching authority records for headings that contain the percent (%) symbol

Do not use the % symbol when searching the authority file. In some cases, keyword searches that includes the percent (%) symbol may result in an error message.

Running IE 8 in Compatibility View required for Keystrokes using ALT key to work

For information on running Connexion in Compatibility View see Workarounds for problems using Connexion with IE7 and IE8

ALT + O to move to the Home screen and ALT + D to move to Dewey Services will not work in Compatibility View. They can be set on custom keystrokes.

Variable fields do not display in records

Ask your IT staff if they are using a content monitor called WebSense. If so, change the category in WebSense from Elevated Exposure to Education. If you do not use WebSense, ask your IT staff to modify settings on the proxy server or firewall to allow http://connexion.oclc.org through.
Change to searching behavior resulting in "No records found for your search"

As part of the most recent Connexion install, an unexpected change was introduced to authorities searching. In some cases, searches that used to retrieve results are not failing and present the message: "No records found for your search".

An example of this is:

\[\text{pn: brahms and ti: op 8}\]

However, if the search was input separating the elements op and 8, the search would present the appropriate records.

\[\text{pn: brahms and ti: op and ti: 8}\]

If a search returns the message "No records found for your search", OCLC recommends re-trying the search and separating multiple elements into separate intake boxes or by adding the word 'and' if using the command line (e.g., ti: no 7 entered as ti: no and ti: 7).

Labels "file could not be located" error message

When trying to view labels, if you get the error message "OCLC Cataloging Label Program. An error occurred with file: [filename and location]. The file could not be located," this may be a problem with the browser cache files. When this occurs, open Tools/Internet Options/General/Temporary Internet Files/Settings/View Files and manually delete the cache.

Labels with diacritics

When printing labels from the Connexion browser with the OCLC Cataloging Label Program, diacritics are displayed and printed incorrectly. The Connexion client handles diacritics correctly. A third-party label program that can handle Unicode can also be used to print labels containing diacritics from a file created in the browser.

Multi-record extractor

There are multiple problems with the multi-record extractor. Until these problems are corrected, libraries should use single record-create extraction.

Automatic sort of bibliographic constant data search
results does not work

When you retrieve bibliographic constant data records, the list is not sorted alphabetically by constant data name as it should be. To sort by name, open the Action/Sort list and click **Sort By Name**.

Pathfinder CD: Cannot apply default constant data automatically when creating a pathfinder

When you create a pathfinder record and attempt to include default constant data automatically, your action ends with the misleading error message:

"Your default constant data has been deleted (5462)."

**Workaround:** Apply your default constant data manually.

### Using Internet Explorer 7 and 8 with Connexion

<table>
<thead>
<tr>
<th>ISSUE</th>
<th>DATE IDENTIFIED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problems using IE7 and 8 with Connexion browser: Workarounds</td>
<td></td>
</tr>
</tbody>
</table>

Users have requested information regarding Connexion's compatibility with Internet Explorer 7 and 8 (IE7 and IE8). OCLC supports Internet Explorer 7 or 8 for use with Connexion browser. Issues are addressed through application changes or suggested workarounds.

The attached document describes problems that Connexion browser users may encounter with IE7 and IE8 and explains a workaround to address each issue.

**Workarounds for problems using Connexion with IE7 and IE8**
## Problems with CatExpress

<table>
<thead>
<tr>
<th>ISSUE</th>
<th>DATE IDENTIFIED</th>
</tr>
</thead>
<tbody>
<tr>
<td>March CatExpress Transaction Report Delay</td>
<td></td>
</tr>
</tbody>
</table>

Due to a recent system update, CatExpress Transaction reports for March and April will only include Current Month results. The Year To Date results will not be included. To obtain current Year To Date activity totals, use the Year To Date activity provided in the February report and add to the Current Month activity for March and April. We apologize for any inconvenience this may cause.

## Problems with local holdings maintenance

<table>
<thead>
<tr>
<th>ISSUE</th>
<th>DATE IDENTIFIED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot print local holdings constant data records from Actions drop-down list</td>
<td>February 20, 2006</td>
</tr>
</tbody>
</table>

When you try to print local holdings constant data in display or edit mode using Print on the Actions drop-down list, a blank record prints.
Problems with controlling headings
Controlling headings that contain the subdivision Colonies causes the geographic subdivision to switch places with the topical subdivision.

This combination of place with colonies is an issue within the heading control software for subjects. There is a portion of that process that looks at subdivisions and whether they can be geographically subdivided and then moves the geographic subdivision to that spot. In the case of these headings with colonies where you can further subdivide by a continent like Africa or Asia, we have two geographic subdivisions that are separated by a topical subdivision and the software doesn't get them into the correct order. We've known about this for a while and have a ticket in place with our developers to try and get that fixed, but that has not happened yet. So, once controlling is adjusted we'll be able to go back through and control them correctly. Otherwise, you ought to be able to add such a heading to a record, leave it uncontrolled, and make use of it that way.

Example:

LCSH entered correctly: Indigenous peoples--France--Colonies

Controlled LCSH: Indigenous peoples--Colonies--France

After controlling a heading, you find that the $x (or $v) is incorrectly changed. The Control Headings window did not open when you used the control headings command. Instead, the incorrect heading was automatically inserted into the bibliographic record.

In most cases, this scenario results from the presence of a pre-coordinated authority record. Because the system tries to match the heading to the fullest form, normalization finds the full heading and changes $x to $v (or vice versa).

Workaround/Example: You can block the system from finding the fullest match upon the initial query.
For example, if you control the heading *Education $x Exhibitions*, the system changes it incorrectly to *Education $v Exhibitions* based on the authority record sh 85041006.

To block this match, in the record, enter the heading with a typographical error in the subdivision (for example, *$x Exhhibitions*) and then control the heading. The error you introduced prevents a match to the incorrect heading. Instead, the Control Headings window opens.

In the list of headings, click **Modify Heading** next to the heading *Education* to move the controlled portion of the heading into the modified heading area.

In the New Query box, enter **$x Exhibitions**, and click **Match Best**. You now have the following choices:

1. **Append to Heading**
2. **Append to Heading**

   - **3. $x Exhibitions** [Subdivision record]
   - **4. $v Exhibitions** [Subdivision record]

Click **Append to Heading** next to the correct subdivision, *$v Exhibitions*, to complete the heading, and then click **Insert Heading** to insert it into the bibliographic record.

### Series headings in 8XX fields

Although 8XX fields are controllable, if an authority record does not exist for the title part of a series name title heading in fields 800, 810, 811, or 83X, and you try to partially control the heading (in addition to leaving the $v uncontrolled), the tag automatically flips from 8XX to 7XX.

**Series headings in 8XX fields**

Although 8XX fields are controllable, if an authority record does not exist for the title part of a series name title heading in fields 800, 810, 811, or 83X, and you try to partially control the heading (in addition to leaving the $v uncontrolled), the tag automatically flips from 8XX to 7XX.

#### Bibliographic record contains “controlled” 6xx headings with second indicators other than 0

In some bibliographic records, headings tagged as 6xx with indicators other than 0 (zero) are incorrectly highlighted as controlled headings. Staff are working to resolve the problem.
After controlling a heading, the punctuation in the controlled heading differs from the punctuation entered, and/or from the punctuation present in the authority record (Revised)

Revised following system installation 05/15/2011.
When controlling headings, the system matches headings against the authority file. This matching process invokes a normalization process, which collapses all punctuation and spaces, removes subfield delimiters and codes, and is not case sensitive.

Workaround: If punctuation is incorrectly altered when you control a heading, uncontrol the heading, correct the punctuation, and leave the heading uncontrolled. See more information in Technical Bulletin 259R, Authorities System Changes about new punctuation rules for controlling headings.

A note about incorrect punctuation in the authority record. The following is a new recommendation:

• If the authority record is not punctuated correctly, then the controlled heading in the bibliographic record will contain the same incorrect punctuation.

• In this case, OCLC prefers that you control the heading that contains the incorrect punctuation and then report the incorrectly punctuated authority record to authfile@oclc.org.

Cannot control headings with subfield i followed by a relationship verb such as "contains"

You cannot control headings that begin with subfield i followed by a phrase that begins with a relationship verb; for example, "$i contains information".

The control process returns a controlled heading in which the tag has mysteriously changed (Revised)

Revised following system installation 05/15/2011. When controlling headings, the system matches headings against the authority file. The matching process invokes a normalization process, which collapses all punctuation and subfield codes, is not case-
sensitive, and does not retain the tag information associated with the heading. The matching process finds the fullest match possible, but sometimes, the results of normalization, combined with finding the fullest match, could result in tag flips if the system completed automatic controlling.

With authorities system changes (05/15/2011), the system does not control the heading and flip the tag when this is the case. Instead, the Control Heading window opens so that you can review results and select or build an appropriate controlled heading. For more information and examples, see Technical Bulletin 259R, Authorities System Changes.

**Cannot control headings with open date (including hyphen) containing a geographic subdivision**

You cannot control headings of the type:

650 0Israel-Arab Border Conflicts, 1949-$z Lebanon

These are cases when a pre-coordinated authority record ends in an open date (and includes a hyphen) and contains a geographic subdivision.

Currently, when attempting to control headings of this type online, the controlled inserted record in the bibliographic record appears as:

650 [blank]0 Israel-Arab Border Conflicts, 1949- ‡z Lebanon. February 7, 2013

A workaround for this problem is to add another subdivision that requires the Controlled Heading Window to open:

For example, enter the heading:

650 [blank]0 Israel-Arab Border Conflicts, 1949- ‡v Periodicals ‡z Lebanon

When the list of headings is presented, the line number associated with the correct form (Israel-Arab Border Conflicts, 1949- ‡z Lebanon) and the heading will be inserted without the incorrect character between the $z and Lebanon.
There are situations in which headings are presented as controllable, but when a user attempts to insert them the heading is not successfully inserted into the bibliographic record. An example of this is when attempting to control the heading:

600 10 Mah, Stuart $v Correspondence.

The following headings are presented in the Control Headings window:
- Mah, Stuart ‡t Correspondence >> Mah, Stuart. ‡t Correspondence. [600 Partially-controlled]
- Mah, Stuart ‡v Correspondence >> Mah, Stuart ‡v Correspondence. [600 Fully-controlled]

Both headings are presented with the option to either Modify Heading or Insert Heading. But at this time, if a user attempts to insert the heading, other pages are presented but the user cannot successfully insert the heading.

Series headings

Currently, only series headings coded as 8xx are candidates for controlling. While series headings are access points, the primary function of the 4xx fields is to reflect the transcription of series statement on an item, and secondarily to provide access as a series added entry. Currently, if 440 fields were controlled, the 'correct' 440 heading text could be incorrectly changed to the new heading in the authority record. This would result in the loss of the field's primary function of transcribing the series statement as found on the item.

Cannot control headings when the main heading and subdivision are the same

You cannot control a heading that repeats the same text as main heading and subdivision, as in the following
example:

**Example**: 650 [blank] 0 History $x$ Study and teaching (Higher) $z$ Poland $x$ History

Currently, there is no workaround. You must leave headings uncontrolled when the main heading and subdivision are the same text.

## Troubleshooting checklist

The following questions, issues, and instructions may help you pinpoint or resolve problems you encounter while using Connexion browser.

### 1. Collect information.

The following questions will help you define the problem:

- What are the symptoms?
- When did this problem start?
- Can you recall any exact error message text?
- Does this function work properly when you use Connexion browser on other computers in your office?
- Has Connexion browser ever worked on this computer without these problems?
- Does the problem occur in the same place every time, such as clicking a particular link or performing a search with specific data?
- Can you provide the HTML source for the screen you were using?

**First step (any browser)**: Right-click within the frame (screen area) that shows the problem, such as record text or a results list; do not right-click on the navigation bar, header bar, jump bar or command list. Then follow the procedure for your browser.

**Internet Explorer**: On the popup context menu select **View Source**. In the window containing the HTML code, open the File menu and select **Save As**. In the Save As dialog box, specify a location and then click **Save**.

Submit the source file with your problem report. Screen captures can be useful as well, to document complex error messages or dialog boxes.

- Are you using PopNot or another program that prevents pop-up windows from opening? Such a programs may reside under your browser’s toolbar.

Note: A bug in PopNot prevents it from working properly with some Connexion screens. When you turn off PopNot by right-clicking its icon (so that the light bulb icon is visible on the taskbar but dimmed), the program remains resident and can still cause problems. You must completely exit or stop PopNot to avoid these problems.
2. Verify that you are using supported versions of your operating system and browser.

   • For the Microsoft Windows version, click the Start button on the taskbar and look at the left side of the start menu. Or right-click on My Computer, click Properties, and select the General tab; operating system and service pack versions are listed under System.
   • For the Internet Explorer version, open the Help menu and select About Internet Explorer.

3. Confirm that you are not using the Back button, Refresh button, or Stop button within OCLC Connexion browser.

Using these buttons can cause errors because what appears on your screen does not match what the servers are doing behind the scenes.

4. Check the browser's cache settings.

Using the recommended settings can improve browser performance by instructing the browser to display stored pages, rather than download fresh pages from the server, when revisiting a site.

Recommended cache settings

   • Set your browser to refresh Web pages automatically when necessary. Do not specify that the browser refresh a page each time you view it.
   • Allocate adequate disk space for the browser cache. 10 MB is recommended. Do not specify zero space for the cache, and avoid allowing it to be larger than 50 MB.
   • Do not configure Internet Explorer to clear the cache each time you exit the browser
   • Retain the browser's History (log of recently visited sites) for 4 days.
   • Before changing settings. Before changing cache/history settings, write down your current settings so that you can restore them if the new settings cause problems.
   • If you experience problems with Connexion browser or with other web-based applications when using the recommended cache settings, see 6. Resolve caching problems.

Internet Explorer

1. On the Tools menu click Internet Options.
2. On the General tab, under Temporary Internet Files, click Settings.
3. In the Settings dialog box, under Check for newer versions of stored pages, click Automatically.
4. Under Amount of disk space to use, type 10 in the text box.
5. Then click OK to close the Settings dialog box.
6. On the General tab, under History, for Days to keep pages in history, type 4 in the text box.
7. On the Advanced tab, under Security (the last group of items in the list), clear (uncheck) the check box labeled Empty Temporary Internet Files folder when browser is closed.
8. Click OK to close the Internet Options dialog box.

https://help.oclc.org/Metadata_Services/Connexion/Connexion_known_issues/Connexion_browser_known_proble…
Printed: Sat, 20 Nov 2021 23:31:55 GMT
5. Clear the browser cache.

Work through all of the steps for your browser and then restart your browser; do not restart after each configuration change.

If your institution uses a firewall or proxy server, that program may also have a cache.

- If you experience JavaScript errors immediately after a Connexion release, try refreshing affected pages first, or clear your cache once rather than changing your settings.
- Other symptoms of caching problems include: old data repeatedly appearing; check boxes not remaining selected; and changes not being retained.
- For best browser performance, do not clear the cache more often than necessary.
- If clearing the cache does not solve a persistent caching problem, see 6. Resolve caching problems.

Internet Explorer

1. Log off Connexion browser.
2. Close all Internet Explorer windows, including popups. This step is essential for your cache to be cleared completely.
3. Start just one Internet Explorer window and navigate to a non-OCLC site such as Yahoo or Google. Do not start any other IE windows until after you complete the cache-clearing procedure.
4. On the Tools menu click Internet Options.
5. On the General tab, under Temporary Internet Files, click the Delete Files button.
6. In the Delete Files dialog box, select the Delete all offline content check box and then click OK.
7. Click OK to close the Internet Options dialog box.
8. Close, and then restart, Internet Explorer.

Note on cache size

By default, recent versions of Internet Explorer assign a very large value for cache size. In some cases it may be 200 MB or higher. Unless you regularly download many large video or Flash files, we recommend that you reduce the value for ‘Amount of disk space to use’ to 10 MB. This is more than sufficient for most users and greatly reduces browser overhead for maintaining the cache.

Mozilla and Firefox generally default to between 5 and 50 MB of cache. You can accept their defaults unless you experience performance problems. To improve performance, it may help to change the cache size to 10 MB. A cache that is too large often causes just as many problems as one that is too small.

6. Resolve caching problems.

- If after using the previously recommended cache settings and occasionally clearing the cache, you observe caching problems, you may need to change cache settings to correct the problem.
- Suggested changes. This section recommends that you set your browser to refresh pages every time you visit a page. Using the settings given in this section slows performance but can improve reliability when a workstation has a cache problem that causes the browser to display expired pages or incorrect data.
• These settings should be compatible with other web-based applications, including the following OCLC services: FirstSearch and NetLibrary.

• **Before changing cache settings.** Before changing cache settings, write down your current settings so that you can restore them if the new settings cause problems.

**Internet Explorer**

1. On the Tools menu click **Internet Options**.
2. On the General tab, click **Settings**.
3. In the Settings dialog box, under Check for newer versions of stored pages, click **Every visit to the page**.
4. Then click **OK** to close the Settings dialog box.
5. On the General tab, under Temporary Internet Files, click the **Delete Files** button.
6. In the Delete Files dialog box, select the **Delete all offline content** check box and then click **OK**.
7. On the Advanced tab, under Security (the last group of items in the list), select (check) the check box labeled **Empty Temporary Internet Files folder when browser is closed**.
8. Click **OK** to close the Internet Options dialog box.

7. **Does the problem happen only when you perform a specific workflow?**

If so, test with the same operating system version and browser version to verify the problem can be duplicated on a separate computer and/or that the problem can be duplicated by your technical staff. If you plan contact OCLC Customer Support, write down the steps that produce the problem (your workflow) so that CSD staff can use the same system and browser versions and follow your exact workflow to verify the problem.

8. **Check with your system administrator to determine whether a firewall or proxy server is caching Web sites.**

If so, have the administrator exclude any caching for OCLC Web sites. It is preferable to exclude the entire oclc.org domain if the firewall supports this approach. If you cannot exclude the entire domain, exclude the following specific addresses: connexion.oclc.org, illweb.oclc.org, firstsearch.oclc.org, catexpress.oclc.org, and www.oclc.org.

9. **Check the browser’s security and privacy settings.**

**Internet Explorer**

Internet Explorer has security options that you can customize to provide different levels of security for different categories of Web sites. The best strategy is to add the OCLC sites to the Trusted Sites zone so security to other sites is not affected.

1. On the Tools menu click **Internet Options**.
2. Choose the Security tab and select the **Trusted Sites** icon.
3. Set the security level to **Low**. If security for Trusted Sites is set to Custom, click the Custom Level button. In the Security Settings dialog box, in the Reset to: list, select **Low** and then click the **Reset** button.
4. Click the **Sites** button and clear the **Require server verification** check box.
5. Add http://*.oclc.org to the Trusted Sites zone.
6. Click OK to exit the Trusted Sites dialog box.
7. On the Privacy tab, adjust the setting to Medium or Medium High.
8. Click OK to close the Internet Options dialog box.
9. Restart Internet Explorer to ensure changes take effect.

10. Check the browser's proxy settings, connection options, and other network preferences.

Internet Explorer

1. On the Tools menu click Internet Options.
2. Click the Connections tab.
3. If you are connecting through a local area network, there should be no dial-up sites listed in the Dial-up Settings box. If you are connecting through a dial-up connection, verify the correct connection is selected.
4. For a LAN connection, select the LAN Settings button. For a dial-up connection, select the correct connection and click the Settings button.
5. Clear the Automatically detect settings, Use automatic configuration script, and Use a proxy server check boxes if they are selected.
6. Click OK to close the Internet Options dialog box.
7. Restart Internet Explorer to ensure changes take effect.

11. Check that content managers are not being used.

Content managers or filters can interfere with the display of OCLC content. Products such as Cyber Patrol, Net Nanny, Cyber Sitter, SurfWatch, and WebSense filter out or limit content from Web sites based on certain criteria. These products can erroneously deny access to OCLC's Web interfaces. Or they may prevent the use of certain features, producing strange results. In Internet Explorer, check the Content tab in the Internet Options dialog box. Ask your system administrator whether any content managers are in use, and provide addresses for the OCLC Web interfaces you use. All content managers should be disabled while using Connexion browser.

12. Ask your system administrator to rule out network problems.

Administrators can test by using the ping and tracer functions and network troubleshooting tools.